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1 Introduction

1.1 Intended readership

This manual is intended for the user of the ISDAT cuitm client within the CSDS User
Interface ISDAT Client package.

1.2 Applicability of the manual

The current version of the document applies to the ISDAT version 2.2, delivered as release
4 within the CSDS User Interface Project. It is valid for UNIX, SUN Solaris workstations.

1.3 Purpose of the CSDS UI Data Manipulation software

The purpose of the CSDS User Interface Data Manipulation software package, of which
cuitm is one component, is to provide the scientific community with software tools to
manipulate and display Cluster CSDS summary and primary parameters. The cuitm
client is a time manager that is used to coordinate the behaviour of an associated family
of ISDAT clients.

1.4 How to use this document

This document consist of an overview of the software in order to familiarize the user with
the capabilities provided. The User Instructions section (3) should be read in connection
with the first hands-on encounter with the cuitm. For the experienced user, a User

reference section (4) is provided. A complete list of error messages is provided in Appendix
A.

1.5 Related documents

An overview of the CSDS UI ISDAT Server Package is given in [Ref. 2]. It is assumed
that the reader is familiar with the information given in that manual. The installation
of the ISDAT package is described in [Ref. 1].

1.6 Conventions and acronyms

In the following, we will use:
e italics to indicate exact names or expressions.
e Courier fonts to give command line expressions.

e > to indicate the terminal prompter.
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Acronym Meaning

ANSI TBW

CDF Common Data Format

CD-ROM  Compact Disc Read Only Memory
CSDS Cluster Science data System

CUI CSDS User Interface

IRF-U Institutet for Rymdfysik, Uppsalaavdelningen
Swedish Inst. of Space Phys., Uppsala Division

ISDAT Interactive Science Data Analysis Tool

Ul User Interface

UR User Requirement

Table 1: Acronyms and abbrieviations

Acronyms and abbreviations used are described in Table 1.

1.7 Problem reporting

Problems should be reported to the CSDS National Data Centre.

2 Overview of the CSDS UI ISDAT cuitm client

The scope of the CSDS UI ISDAT cuitm module is to provide a general purpose time
manager for ISDAT. Cuitm is an ISDAT client that is used to coordinate the behavior of
a family of associated clients (by clients in general, we understand analysis and display
clients by which the user interacts with the CSDS UI ISDAT). It may be used to activate
another client, to select a project or to select data file.

3 User Instructions

3.1 Getting started

The cuitm module can only be started if an ISDAT server is running on the server host.
You can start cuitm from the CSDS User Interface Session Manager or from the command
line by typing

cuitm

and return. However, in order to acquire the access code for the CSDS data bases at the
CSDS National Data Centres, it has to be started via the CSDS User Interface session
manager.
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ISDAT cuitm

Figure 1: The cuitm window

3.2 Using the CSDS UI cuitm client

The cuitm window in its original configuration displays the following commands and
informations to the user (Figure 1):

e The main Menu: The main menu bar contains the following fields:

— File menu:
x Config:

- Load: is used for loading a configuration file. This configuration file is
created when the user presses the Config—Save button. The config-
uration file is an ASCII file. When the Load button is pressed a File
Selection dialog appears. The user selects the correct file and presses
the OK button. When the configuration file is loaded the cuitm client
gets the same configuration as when this file was stored.

- Save: is used to save the complete status of the cuitm client to a file.
This file is an ASCII file and is named the configuration file. When
the Save button is pressed a File Selection window appears. The de-
fault filename is SHOME/cuitm.conf. This file is selected in the Files
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panel and then the filename appears in the Selection line. The user
presses the OK button to save the file. The program checks if the file
name is valid (and not a directory). If the file already exists a warning
dialog appears. The user then presses OK to overwrite or Cancel. All
parameters are saved except Interactive Time Selection. The configu-
ration files are ASCII files and can be interchanged between different
users (e.g. with e-mail).

x new-manager (CTRL-N): to start a new manager to run simultaneously
with the current manager. The new manager will connect to the current
server.

x new manager & database (CTRL-L): start another manager and connect
to an arbitrary ISDAT server. The user is asked to specify the new server
in the format ”host:server_no” or to confirm the default specification. The
default server can be changed by setting the LOCAL_DATABASE envi-

ronment variable.
* erit: to stop the current time manager including all its child-clients.

— Clients menu: This menu displays in different entries all clients registered at
start time. You always find one entry general that has as sub-entries allgeneral
clients (meta client for instance). You find also a list of project names with
project specific clients as sub-entries. Click on the wanted client to start it.

— Information:

x server (CTRL-S): displays the current server name.

x version: gives the current CSDS UI version number and patch level.
— Options:

* auto update (CTRL-A): when the user enables auto update mechanism,
all changes in time selection will automatically trigger an event Update
sent to all child-clients.

* step (CTRL-T): displays the step time editor; Step value then supersedes
the Interval value whith previous step, next step and continuous actions.

« continuous (CTRL-O): displays the continuous editor; when the user en-
ables Run button, an update event is sent to all child-clients , from Start
value to Continuous value with steps of Step value (if set) or Interval.
The user can stop and resume the operation by pressing or releasing Run
button.

— Help:
x Help...: displays helpful information.

e The specification Frame: The first action of the user is probably to select his project,
one corresponding member and instrument. First of all, the user selects the project
in the project list, then one of the selected project member in the member list
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and one of the selected member instrument in the instrument list. The available
instruments etc. may depend on the access rights of the user. The user can set the
default start specification in the .isdat.client file (see [Ref. 2]).

e The time selection Frame: At start time, the time selection Frame displays the
Start, Interval and Stop time fields. Additional Step and Continuous fields are
displayed when corresponding Options are triggered from Options menu. The user
can set the default times in the .isdat.client file.

The search time start and stop times can be edited by using standard X-windows
functions. The allowed time specification formats is essentially the CCSDS ASCII
Calendar Segmented Time Code i.e.:

YYYY-MM-DDThh :mm: ss.ddddZ

where: YYYY is the year with possible values 0001 - 9999
MM is the month with possible values 01 - 12
DD is the day with possible values 01-28, 29, 30, Or 31
T 1is a date-time separator, always ASCII character T
hh is the hour with possible values 00 - 23
mm is the minute with possible values 00 - 59
ss is the second with possible values 00 - 59
dd is the fractions of seconds with possible values 0-9
Z 1is a mandatory terminator, always the ASCII character "Z"

In addition as deviations from the standard it is legal to replace "T" with a
space " ", and also make the trailing "Z" optional. It would thus be legal to
write:

1996-02-22 13:47:32.247 or
1996-02-22T13:47:32.247Z or
1996-02-22 13:47:32.2470000

— Start field: start time for the next data interval.

— Interval field: interval for the next data interval.

Stop field: stop time for the next data interval. It is automatically updated to
show start + interval .

— Step field: step value.

Continuous field: end time when continuous mode is set.

e The Interactive Time Selection Frame: At start time, the frame is empty. When
the user selects a data interval from the Database Content List or from the CSDS
Catalog List, a symbolic line is displayed to represent segments of available data
sets within the selected interval. By selecting different contiguous segments with
the mouse, the user updates the next data interval. The current interval is shown
as a separate (blue) line in the Interactive time selection area above the symbolic
time line, see Figure 2. The symbolic and selection lines are updated when a new
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ISDAT cuitm

Figure 2: The cuitm window with the current interval shown
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selection is made from either the Database Content List or the CSDS Catalog List.
The Buttonl of the mouse is used to create a new selection line. The Button2 is
used to shift the selection line.

e The action Frame: This frame allows the user to trigger the following actions:

— TO-the-LEFT ARROW: (previous step) this button substracts Interval (or
Step if it exists) from the current Start and then perform an Update.

— TO-the-RIGHT ARROW: (next step) this button adds Interval (or Step if it
exists) from the current Start and then perform an Update.

— Update: when the user presses this button, an update event is sent to all
child-clients, and they are normally updated to analyze and show data for the
current Interval.

— Content: opens the Database Content window that lists the available data sets
for the current project-member-instrument specification. By selecting several
contiguous data sets, the user updates the Start, Interval and Stop Fields.

— Catalog: opens the CSDS Catalog window that displays CSDS results after
a query from ESRIN Session Manager. By selecting several contiguous data
sets, the user updates Start, Interval and Stop fields. If no catalog is available,
the button becomes insensitive. The existence or upgrading of catalog results
is checked every second.

— Size Icon: the user can reshape cuitm by pressing on this button. By pressing
again, it returns to its normal shape.

— To the right of the size icon there is an empty field that will show the current
activity in case of time consuming activities.

3.3 Example of a session and expected results

e START:
— Start cuitm from ESRIN Session Manager or from command line.

— Select a Project (ex: 'CSDS_PP’), a corresponding Member (ex:’C1’) and In-
strument (ex:’efw’).

— Press Content button and select several contiguous data sets among the list:
Start, Interval and Stop fields have been upgraded;

— In the Clients menu, select the wanted child-client.
e NEW TIME:
— Enter new times with the keyboard in the time fields.

— Press Update button: the child-client state will change and accommodate the
new times.
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— Press TO-the-RIGHT ARROW to add Interval time to Start and Stop fields:
an Update is automatically performed on the child-client.

e AUTOMATIC UPDATE:
— Select auto update in Options menu.

— In the Interactive Time Selection Frame, select a new interval with the mouse
: the child-client will be noticed of every time changes.

e EXIT:
— Select ezit in the File menu.

— Confirm exit in the opened window.

3.4 Common errors and probable causes

The most common errors are explained in [Ref. 2].

4 User reference

This section is also available on-line.

NAME
cuitm - coordinate the behavior of an associate family of clients.

SYNOPSIS
cuitm

ARGUMENTS
Handles all generic ISDAT and X arguments.

DESCRIPTION
Cuitm is an ISDAT client of type '"time manager". It is designed to
coordinate several associated clients. The coordination is based on a
common time. The major functions of a time manager are: To activate other
clients: /* TO BE FILLED */
Menu bar entries:

File (META-F) . with buttons:

new manager

Press this button to start a new manager to run simultaneously
with the current manager (CTRL-N).

Exit
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To exit the client (CTRL-E).
Clients (META-C).
This menu displays in different entries all clients registered at
start time. You always find one entry ’general’ that has as sub-
entries all general clients (’meta’ client for instance). You find
also a 1list of project names with project specific clients as sub-
entries. Press on the desired client to start it.
Information (META-I) with buttons:

server

Displays the current server name in a dialog window (CTRL-S).

version

Gives the current CSDS UI version number and patch 1level (CTRL-
V).

Options (META-0) with buttons:
auto update

When you enable auto update mechanism, every changes in time
selection will automatically trigger an update event sent to all
child-clients (CTRL-A).

step

Displays the step time editor in +the Time Frame. Step value
supersedes then the Interval value whith previous step, next step
and continuous actions (CTRL-T).

continuous

Displays the continuous editor in the Time Frame and the
associated Run button. When the wuser enable Run button, an
update event is sent to all child-clients, from Start value to
Continuous value with steps of Step value (if set) or Interval.
You can stop and resume the operation by respectively disabling
or enabling Run button (CTRL-0).

Help
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Help... gives a short description of the client (CTRL-H).
Specification frame :

The first action of the user is probably to select his project, one
corresponding member and instrument. The user can set the default start
specification in the .isdat.client file. First of all, the wuser selects
the project in the project list, then one of the selected project member in
the member list and one of the selected member instrument in the instrument
list.

Project menu.

Displays a list of available project on the server.

Member menu.

Displays available members for the chosen project. An empty 1list
displays only one

Instrument menu.

Displays available instruments for the chosen member. An empty 1list
displays only one

Time Frame :

At start time, the time selection Frame displays the Start, Interval and
Stop time fields. The user can set the default times in the .isdat.client
file. Additional Step and Continuous fields are displayed when
corresponding Options are triggered from Options menu. All time fields are
editable and you can enter desired interval in seconds with the following
format ’YYYY-MM-DD hh:mm:ss.decimals of seconds’

( ex: ’1996-01-03 00:00:01.0°). Optionally the time can be given as:
?1996-01-03T00:00:01.0Z" .

Only digits, spaces and ’.’, and ’T’ and ’Z’ characters can be entered.

Start

Displays the start time for the next data interval.

Stop

Displays the stop time for the next data interval. It is automatically
updated to show start + interval.
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Interval

Displays the interval time for the next data interval.

Step

Displays the step time value.

Continuous
Displays end time when continuous mode is set.

Interactive Frame
At start time, the frame is empty. When the user selects a data
interval from the to represent segments of available data sets within
the selected interval. By selecting different contiguous segments
with the mouse, the user updates the next data interval.Back and Forth
selection is available. The current interval is shown as a separate
(blue) line in the ’Interactive time selection’ area above the
symbolic time line. The symbolic and selection lines are updated
when a mnew selection is made from either the ’Database Content List’
or the ’CSDS Catalog List’. The Buttonl of the mouse is used to create
a new selection line. The Button2 is used to shift the selection line.

Action Frame
Update button
When you press this button, an update event is sent to all child-
clients, and they are normally updated to analyze and show data for
the current Interval.
Left arrow
(previous step) When you press this button, it substracts Interval(or
Step if it exists) from the current Start and then perform an Update.
Right arrow

(next step) this button adds Interval (or Step if it exists) from the
current Start and then perform an Update.
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Content

It opens the ’Database Content’ window that lists the available data
sets for the current project-member-instrument specification. By
selecting several contiguous data sets, the user updates the Start,
Interval and Stop Fields.

Catalog

It opens the ’CSDS Catalog’ window that displays CSDS results after a
query from ESRIN Session Manager. By selecting several contiguous
data sets, the user updates Start, Interval and Stop fields. If no
catalog is available, the button becomes insensitive. The existence or
upgrading of catalog results is checked every second.

Size arrow

the user can reshape cuitm by pressing on this button. By pressing
again, cuitm returns to its normal shape.

ERROR MESSAGES
At start time: MESSAGE:"can’t open display" The DISPLAY envir. variable
should be set.
MESSAGE:"can’t connect to database xx" The xx server is not running on the
server host. Contact the manager of the host machine to (re)start the

Server process.

Errors originating in the database, such as "bad time" or "bad semsor", will
be printed in the cuimeta text field.

SEE ALSO

5 Known bugs

There are no known bugs.

A Error messages

See section 4
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